CDOT Sheet File Creation — Multiplem
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This document guides you through creating a sheet file with multiple scales. First, we will be
going over placing the sheet border around coordinate based model graphics. Then, we will go
over attaching and scaling additional model files. Lastly, placing text and dimensions in the sheet
file will be covered. For setting up plan sheets see the CDOT Sheet File Creation document.

Note: This example uses details from the Bridge discipline. This procedure
applies to any sheet file with multiple scales. If you are in another
specialty, please substitute with your specialty group’s information.

Setting up the Sheet File with Multiple Scales:

Beginning a New Drawing File

1. From the MicroStation Manager, create a new file by <D> on the New File icon.

M =
Lookin: [ Drawings e f e m &
Name ‘-l Date modified |-| Type |'| Size -
N > Reference_Files 12/13f2008 1:35... File Folder
Recent Places Tabs 11/21/2007 2:38... File Folder
Desktop
—
IJ !
148
CDOT User
o ™
s
‘Computer
[ W
==
Network
File: name: | ﬂ Open User: |CDOT User -
Files of type: |CAD Fies (* dan:” dwa:" d:d) = Cancel Project: | 12345 B
I Open as read-only Interface: [CDOT -

2. Verify that the correct Seed File is selected. If it is not, <D> Browse and
Navigate to C:\Workspace\Workspace-CDOT_XM\Standards-
Global\MicroStation\Seed\.

A New - C:\Projects\12345\Bridge\Drawings\ ﬂ
Save in: | Drawings j [« N M g =
Name |v| Date modified |v| Type |v| Size |v|
&E? Reference_Files 12f13f2008 1:35... File Folder
Recent Places Tabs 11212007 2:38...  File Folder
Desktop
—
i
i
COQT User
o ™
s
‘Computer
A
==
Network
File name: |123455RDG_DBia\ID1 dan j Save
Save as type: MicroStation DGN Files (".dgn) ﬂ Eac ‘
Seed: IC “WorkspaceWorkspace-CDOT_XM\Standards-Global\MicroStation\seed\30-Seed_CDOT .dgn I Browse ‘
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3. Enter a drawing file name that corresponds to the next consecutive sheet number.
<D> Save to create the new file.

M New - C:\Projects\12345\Bridge\Drawings\ ﬂ
Save in: I | Drawings j @ _? = ' E
Mame = |-| Date modified |-| Type |-| Size |-|
| Reference_Files 12/13/2008 1:35... File Folder
J\J Tabs 11/21f2007 2:38... File Folder

File name 12345BRDG_Detail01.dgn hd I Save
Save as type MicroStation DGM Files {".dgn) - Cancsl

Seed: IC\Worksuace\Wol‘n:space-CDOTﬁXM\Standards-Gluba\\MimStai\on\seed\SD-SeedfCDOT.dgn Browse I
4
4. The file you created will be highlighted. <D> Open to open the file.
M MicroStation Manager - C:\Projects\12345'\Bridge\Drawings\ ﬂ
Look n: [ ] Drawings I I e = 3D-V8 DGN

Name Ivl Date modified |v| Type |v| Size Ivl
|« Reference_Files 12/13/2008 1:35... File Folder

. Tabs 11/21/2007 2:38... File Folder

leSﬂSBRDG_DeBilOl.dgn 2/21/2009 1:42PM  Bentley MicroSta... 62KB

File name: I123-158F{DG_De{ai|ﬂ1 dan j Open User: ICDOT User vl
Files of type |CAD Fles (* dgn:* dwg.* ddf) = Cancel Project: [ 12246 -|
I Open s read-oniy Dptions Interface: [CDOT -

&
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Attaching Model Files to the Sheet File

1. Select the Reference icon from the Primary Tools toolbar.

Version 04.00

x|
Bo]e-<-2-k-0uz-@

2. From the Reference Manager tool bar select Tools > Attach

I.H References (0 of 0 unique, 0 displayed)
| Tools
Attach... ey = L %
— 3 ¢ * u =
Model Description Logical Glld% [
|
| [
b € =) [ | |

The first model file you reference should be the one containing coordinate based
information. Search for that model file and verify the Attachment Method is
set to Interactive. <D> OK. If you are creating a sheet file containing details
only, with no coordinate based information, bring in the detail with the largest
scale factor first and scale the border to this detail. Once the detail with the
largest scale factor has been referenced, attach the remaining details into the

sheet file following the procedure outlined be

# Attach Reference - C:\Projects\12345\Bridge\Drawings\Reference_Files\
j @ ? o EI'
| R S

Look in: |

Reference_Files

low.

S|

.;I) #1112345BRDG_Model.dgn

12/13/2008 3:37...
Recent Places. T

4

Bentley MicroSta...

B

3D-VBDGN

frmereidh

Attachment Method
Interactive

B

=

File name: |123453RD67MUdE|.dgH

i

Files of type: |CAD Files (".dgn:* dwg:".d«)

-

[~ Save Relative Path

Open
Cancel
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4. Inthe Reference Attachment Settings dialog box, key in a logical name and a
description. For instance, the logical name might be Plan View for the
BridgeModel drawing. The other settings should not have to be edited.
Coincident-World is selected by default. Verify the Scale isto set to 1:1 and
True Scale is checked ON. <D> OK.

# Reference Attachment Settings for 12345DE5_Model.dgn J

File Mame: 123450ES_Model dgn
Full Path: .. \Drawings“Reference_Files*123450E5_Model dgn

Model: [CDOT Default =

Logical Mame: |Plan View

Descrption: | Global Ungin aligned with Master Hle

Crientation:

Wiew Description

Slimned with hil=ots =

] Stangard VIews
Saved Views (none)
MNamed Fences {none)

Toggles:
Scale (Master:Ref) | 1.000000

E Bl eaana

: | 1.000000

| =
| _I|
| I

Mested Attachments: Mo Mesting st | s
Display Cvemides:  Allow b |
Mew Level Display: Use MS_REF_MEWLEVELDM™ |
Global LineStyle Scale:  Master i |

e |

Note: When Coincident World under Orientation is selected and a Scale factor
of 1:1 is entered, plan graphics are being referenced to the sheet file with
the true coordinate information. All other attachment methods will not
maintain the true coordinate values.
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5. The file will be shown in the References dialog box.

# References (1 of 1 unique, 1 displayed)
Tools Settings
= i oy o Ty
EvR D $DEAF P VDO X
Slot | File Name Model Description Logical
1 12345DES_Model.dgn CDOT Default  Global Origin aligned wi... Plan View

4| |
Scale |1.000000 : | 1.000000 Rotation | 0°0°0"

Offeet X [-178956.971 ¥ [-178956.571 Z [-178956.571

[Cla T @ > ¢ @87 NoNesing | | Deptt: [T

Mew Level Display: Config Variable ¥

Note: Whenever you make graphical model file changes, your sheet file will
automatically update.

6. Fit View using the icon () so the graphics for the first model file are displayed.

ERAF RN | AR =S REAR

7. Select File > Save Settings from the Primary toolbar.

L C:\Projects\12345\Bridge\Drawings\12345BRDG_Detail01.dgn (3D -’

File §Edit Element Settings Tools Utilities Workspace Window Help CDOTH

New. .. Cirl+M
" QOpen... cirl+0
Close Ctrl+w
Save Crl+5
Save As
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Rotating the View

1. After the references are attached, you may need to rotate the view depending on
the layout of the sheet.

Note: You are not rotating the reference file(s). You are only rotating the view.
The coordinate system will not change.

2. One option to rotate the view is to Key-in rv = x,y,z and press <Enter> or <Tab>.
# Key-in ﬂ
[v=0.0.60 =

Note: x=0,y=0,and z = Rotation Angle. You are rotating the view about the
z-axis. This is the axis perpendicular to the view. Otherwise, if you are
working in a 2D file the key-in would be rv = value of rotation.

3. You will be prompted to select the view you would like to rotate in. <D> in the
active view window.

Rotate Wiew [Relative] » Select view
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The view will be rotated.

4. Oryou can rotate graphics using 3 Points. Select Rotate View.

=R N RN wlr 7] e =T R RS N
_|'I.ﬁew Rotation: Rotate 'l.n"lew|

Change the Method to 3 Points.

# Rotate View -|=] x|

Method: 3 Points - |

/%P> DATA POINT 2

<D> DATA POINT 3

t=—=—/«D> DATA POINT 1
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Note: Make sure you are picking a data point near the 3D element. Do not
snap to 3D elements because you will be rotating along the z axis instead
of just the x and y plane. Turn Accusnhap off or you can hold down the
<Ctrl> and <Enter> keys down at the same time to temporarily disable
Accusnap while you are locating the data points.

The view will be rotated.

T L R [

Attaching the Border and Resident Engineer Cell

1. Fromthe CDOT Menu, select Drafting > Borders.

EE CDOT Menu ﬂ ﬂ

CDOT Groups  CDOT Tools  Options  Help

F  Status

olidde l?
Construction  Existing + Proposed .
Diesign

Geometry  Drafting

Hydraulics \l Al g;gl @m

Landscape Environmental
Materials Geotechnical n\., Clip Boundary |
ROW Survey ™., Match Line
+- Traffic ITS Baorder RE £ Utilty Revision Cloud
Liilties —— | % Border (Plan 11'<17")
Dimensions %% Border (Plan 11"%8.5") Portrait
T | | % Border (Plan 8.5"%11") Landsc...
X Border (PnP 11"%17")

Patteming % Border (Profile 11"x17")
% Border (Title 11"x8.5") Portrait

Linework

Symbols % Border (Typical Section 11"x17")
X Border Limits {11"%17") |
Text X Call 811 Stamp (Formery UNCC)
% CDOT Logo

X Morth Amow Skier

% Morth Amow Standard v|
Settings... | ﬁ I 4
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2.

Version 04.00

<D> Settings if the desired sheet scale is something other than 1” = 100°. In the
Active Settings dialog box you can change the Active Scale and the Active
Angle. In this example, the standard 11x17 sheet border is too large for the plot
area when the Active Scale is set at 1” = 100’

E&Z Active Settings ﬂﬂ
Active Scale: 100.00 Apphy

Active Angle: 0.00
Close

Prior to placing the border and border information, set the Active Scale. This
should be set to the largest proposed scale factor you plan to have on your sheet.
For example, if you have a plan view that should be plotted at 1” =40’ and a
detail that should be plotted at 1” = 57, the largest scale detail would be 1” = 40°.
Choose a scale factor in even increments such as 10, 20, 30, 40, 50, 60, 100, etc.
<D> Apply.

B Active Settings ﬂﬂ

Active Scale: |4[;.

Active Angle: 0.00 =
0se

Note: The Active Angle is view independent and not associated with view

rotation. Therefore, the x-axis is always horizontal regardless of the view
rotation. You will not need to set this for correct placement of the North
Arrow or other cells.
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4. Select the desired sheet border cell from the list.

EEZ CDOT Menu ﬂﬂ

CDOT Groups CDOT Tools  Options  Help

{Drafting; Status

Bridge
Construction = 95 s

Diesign

Geometry Drafting

Hydraulics \ Al @m

Landscape Environmental

Materials Geotechnical \ Clip Boundary =l
ROW Survey ™, Match Line

+- Traffic ITS Border RE
tilties —————— [ # Border (Plan 11177
Dimensions % Border (Plan 11'x8.5") Portrait
m % Border (Plan 8.5'%11") Landsc...
% Border (PP 11%177)
., % Border (Profile 11"x17")
— |} # Border (Title 11"%8.5") Portrait
Symbols % Border (Typical Section 11"x17"
- 1 order Lms | ! —
Text % Call 811 Stamp (Formery UNCC)
% CDOT Logo
¥ North Amow Skier

% North Amow Standard ’j
[ »

)k[ it ML LI
4
Settings. ..

5. You will then be prompted to locate the lower left hand corner of the sheet
border (the cell’s origin). Move the cell to the desired location and <D>.

Flace Active Cell > Enter cell arigin
6. Select the desired North Arrow. Move the cell to the desired location and <D>.

€= CDOT Menu ﬂﬂ

CDOT Groups CDOT Tools Options  Help

Draﬁ.ng Status
Construction d f*" Proposed

Design

Geometry Drafting

Hydraulics \ -AE:3 @m

Landscape Environmental

Materials Geotechnical \Clip Boundary
ROW Survey ™, Match Line

| v

+- Traffic ITS Border RE 7% Lility Revision Cloud
Lkilities 1 | ¥ Border (Plan 11"x17")
Dimensions % Border (Plan 11"x8.5") Portrait
m %¢ Border (Plan 8.5"x11") Landsc...
# Border (PnP 11"%17")
T % Border (Profile 11"%17")
|| % Border (Title 11"%8.5") Portrait
Symbals % Border (Typical Section 11"x17")
% Border Limits {11"%17") -
Text 4 Call 811 Stamp (Formery UNCC)
& COOT oo
¥ North Amow Skier
%% North Amow Standard

Settings... J | k H
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7. Select a Bar Scale if desired. Move the cell to the desired location and <D>.

EZ CDOT Menu ﬂ ﬂ
CDOT Groups  CDOT Tools  Options  Help
Drafting
Bridge Stat;s e
Construction o
Design
Geometry Drafting
Hydraulics \ Al m
Landscape Environmental
Materials Geotechrical 3 Border (PP 11°%17") N
ROW Survey ¥ Border (Profile 11"%17")
+- Traffic ITS Border RE % Border (Title 11"x8.5") Portrat
Utiities % Border (Typical Section 11"x17")
Dimensions | | 4 Barder Limis (11"%17")
vy % Call 811 Stamp (Formery UNCC)
% CDOT Logo
Patteming % Notth Amow Skier
4 North Amow Standard
Symbols -
#- Scale Horizontal
Text % Scale Vertical
amp FIR

% Stamp FOR

# Stamp Preliminary =

4 [

8. Lastly, select the Border RE button, then select the desired Region Engineer cell.
<T> to the location shown in the illustration below and <D> to accept placement.

Note:

Sheet Revisions

@ SNAP

Contact the CADD Manager if any edits need to be made to a Region

Engineer cell. Remember, you can edit the cell with the Edit Text
command until the changes are available in the next configuration.
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9. Double click on any of the text fields in the border to add sheet specific
information.

T T T
AL

s Constructea | Prejot No./Gods

PLAN SHEET

Adding Additional Model Files to the Sheet File

1. Once you have referenced the model file with coordinate based information and
added the border, you can begin referencing additional files with various scales.

Select the Attach Reference icon located on the reference file dialog box.
Locate the file you want to attach. <D> OK.

Attach Reference

File Directary

Files: Directories:
| D0000ER DG_D etail_Abutment_Feinf.dg ...%Bridge\Drawings\FReference_Filesh 30 - vEDGN
| DOO0OBRDG_Detall Abutment_Hemfdgni |3 C:\
Q0000ERDG_D etai_Bearing dgn [E= Projects
00000BRDG_Model.dgn (£= 00000
Q00O0ERDG_Prof.dan [ Bridge
(2= Drawings

% Reference_Files

Lizt Files of Type: Dirives: Attachment Method:
MicroStation DGH Files [*.dgn] '] l@ & | | Interactive
oK I Cancel ]

-

[T Save Relative Path |
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2. Inthe Reference Attachment Settings dialog box, key in a logical name and a
description. Set the Orientation to Top and set the Scale. When you set the
Scale, key-in the scale factor of the border sheet into the first field. In this
example it is 40. In the second field, key-in the scale factor you want the detail
to be plotted at. In this example 5 represents 1”=5. The overall scale factor for
the detail is 40/5 = 8. MicroStation will calculate this for you.

Reference Attachment Settings for 00000BRDG_Det... Formula:
File Mame: 00000ERDG_Detal Abutment_Feinf.dgn
Full Path: . ADDODOBRDG_Detail_Abutment_Reinf.dgn Border Scale: scale the

Model: [COOT Default = .
border cell was inserted

Logical Marmes | Top

Description: | Abutment R einforcing D etail I
Orientation:

Mame Deaatalin = Detail Plot Scale: scale for
Caincident Aligned with M aster Filz speciﬁc detail to be plotted
Caincident - World — Global Origin aligned with Master File

| (See Step 22)

Top Standard Wiew I
[ ANATT W IEw
Right Standard View j

Scale (Master:Ref) [40.00000 : [5.000000 W TiueScale .
I - | Scale Factor: model file

insertion value

Mested Attachments: Mo Mesting b

W Display R aster References

Cancel | _ Options.._| Scale Factor = Border Scale

With the Orientation set to Top, the model file is anchored to your cursor and
you can place it interactively.

__F;'ikiforlncl: {1 of 1 unique, 1 displayed) .!_l
Took  Settings
Er 3 Hiin Mode  Bourdaing v|
Sini | Fie Nomes Mol Diractigrion Logeal Pinsertation | =) ad R |
1 DUUUERDIG_Model dgr COOT Dol Ghobel Ui shgree... Waghae ¥
[z | o T T e [ | d
,—l—,—l—,— |— |— '— :I cratructad e Prejeat Me./Cose
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3. After the model file is positioned in the area you would like, <D> to accept the
placement of the additional model in the sheet file. The model file is placed
relative to your active Z. Verify the active Z by snapping somewhere in the
view, prior to placing the new detail. If the Z is not correct, you can interactively
key-in AZ=0, select the view, hit reset and continue with the reference
attachment.

[l

T N 31
LHRALTE

| )

Profect No./Code

o juct Rurmar

D PLAN SHEET

ot

hooe

Sesthmee  XHX

4. Attach additional model files you would like to add to the sheet file.

M Attach Reference - C:\Projects\12345\Bridge\Drawings\Reference_Files\ ﬂ
Look in: I | Reference_Files j @ ,, £ (G- E 3D - VB DGN
MName = |v| Date modified |v| Type |v| Size
g' 12345BRDG_Detail_Abutment R... 12/13/2008 3:37... Bentley MicroSta...
m 12345BRDG_Detail_Bearing.dan 12/13/2008 3:37... Bentley MicroSta...
12345BRDG_Model.dgn 12/13/2008 3:37... Bentley MicroSta. ..
12345BRDG_Prof.dgn 11/20/2007 8:45... Bentley MicroSta. ..
AMtachment Method
Interactive LI
| | Bl
File name: I123458RDG?Mode4.dgn d Cpen I
Flesoftype:  [CAD Fies "dan” dwa:dd) =l =
e [~ Save Relative Path O ptions |
4
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5. Inthe Reference Attachment Settings dialog box, key in a logical name and a
description. Set the Orientation to Top and set the Scale. In this example the
border cell was inserted at 40 (see Step 22 above), If you want the last detail to
be plotted at a 1"=10’ scale, leave 40 in the first field and key-in 10 to the second
field. The overall scale factor for the detail is 40/10 = 4. MicroStation will
calculate this for you.

M Reference Attachment Settings for 1234EBRDG_DetaiI_Be...J

Formula:
File Name: 12345BRDG_Detail_Bearing.dgn

Full Path: ..\Reference_Files\12345BRDG_Detail_Bearing dgn

Model. |CDOT Defauk =l Border Scale: scale the
I Logical Name: [Top-1 I .
Femm—— border cell was inserted
Crientation:
Wiew Description ;I
Top .
E:m Detail Plot Scale: scale for
Right . .
Isometric specific detail to be plotted
Bottom [
Back (See Step 22)

Lokt El

— Scale Factor: model file
CooyToMager 7| insertion value

MNested Attachments: Mo Mesting ht M

Display Ovenides:  Allow
Mew Level Display: LUse M5_REF_NEWLEVELDM
Global LineStyle Scale:  Master

I oK | Concel | Scale Factor = Border Scale

6. Place the model file interactively and <D> to accept placement in the sheet file.

Shaet Ravisions

Az Canstructad Projest No./Code
PLAN SHEET

XHX
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Additional Sheet File Information

Setting up Text and Dimension Scale in the Sheet File

1. You must change the Annotation Scale Factor if the border cell was scaled to a
factor other than 1:100. Otherwise, the text size in the sheet file will not
correspond to the scale factor chosen when placing the border cell.

2. Select the Models icon from the Primary Tools toolbar.

Blo-e-ac-4-0us-9

X|

3. Select the Edit Model Properties icon

M Models

& ol

Hi=E

TE 2E it Model Properties
[E] CUU | Uetautt

Description
Master Model

4. The Annotation Scale factor defaults to 1:100. Select the arrow to change the
scale factor. If you try to place text before setting this, it will be too large since

the drawing plot scale is at a 1:40.

5. From the pull down, select the Annotation Scale factor to match the scale factor

used when placing the border cell.

6. In this example, an annotation scale factor of 1:40 should display. <D> OK to

accept.

# Model Properties

Type: Design ¥

MName: |CDOT Default

Description: | Master Model

Ref Logical: |
A v ] | |
Line Style Scale: _Annotation Scale R |
[ Update Fields Automatically
Cell Properties
[T Canbe placed as a cell

[

Version 04.00 Page 16 of 18

Updated February, 2009



CDOT Sheet File Creation — Multiple Scales.pdf

7. The following Alert dialog box will be displayed. <D> Yes. The result will be
the updated of any text previously placed in your sheet file.

M Alert x|

‘) Do you want to propagate the new annotation scale to existing

annotations?
L ]

Yes Mo

8. Now, you can add text to the new sheet file. It will be scaled to the correct height
based on the plot scale or in this case 1:40.

M Place Text - o] x|
Method:! By Origin - |
Text Style: [& 07" ENG-100 =]
Active Angle: [0°00.00" H
I_ —
& [
- 3
[ Apply changes to all text Annotation Scale

Lock : OM
Scale ; 40.000000: 1

Note: Annotation Scale Lock must be turned ON when placing text or
dimensions for the scale factor to take affect. Verify it is ON by

hovering with your cursor over the = icon.
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9. You can dimension the model files in the new sheet file. The dimensions will be
scaled to the correct size based on the plot scale or in this case 1:40.

" EE]

[T CDOT 3 > Q 2y
Alignment:  View o
Location:  Automatic w7

o 14

Annotation Scale

¥ Start Edension: F— Biock :0ON
Iv End Bxtension: — " Mscale: 40.000000: 1
Text Alignment: _Standard "%
[ Text Frame: Box ¥
[ Prefic Tet: =] el
i i ot Ef -

Note: Annotation Scale Lock must be turned ON when placing text or
dimensions for the scale factor to take affect. Verify it is ON by

hovering with your cursor over the & icon. Also, verify the
Association is ON so the dimensions will dynamically update when
model changes are made. This setting is turned on by default.

10. The Sheet file now includes text and dimensions for multiple scaled details.

PLEN

ol tremy B dbaimant @ Botton

SECTION 4
RBUTMENT REINFORCING DETAIL

;

| T30
0 I

ELEWATION

L

BEARING DETAIL

Conetructed

PLAN SHEET

11. Select File > Save Settings before you exit MicroStation.
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